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Wprowadzenie 

W analizach struktur krajobrazów wykorzystujących modele geokompleksów albo 

płaty-korytarze-matryca (Forman & Godron, 1991), powszechnie wykorzystywane są tzw. 

miary krajobrazowe (McGarigal & Marks, 1995; Kot & Leśniak, 2006; Urbański, 2012; 

McGarigal et al., 2023). Są to ilościowe wskaźniki opisujące geometryczne i przestrzenne 

właściwości elementów krajobrazu. Do najważniejszych typów należą miary: 

powierzchni i krawędzi (area and edge metrics), kształtu (shape metrics), stref 

centralnych (core area metrics), kontrastu (contrast metrics), fragmentacji 

(aggregation metrics) i różnorodności (diversity metrics) (zob. dokument najważniejsze 

miary krajobrazowe). Z niektórymi miarami krajobrazowymi można zapoznać się 

w prezentacji Miary krajobrazowe. 

Podstawowym narzędziem służącym do obliczeń miar krajobrazowych jest aplikacja 

Fragstats (McGarigal & Marks, 1995; Raines, 2002; Zwierzchowska et al., 2010; 

McGarigal et al., 2023) oraz jego nowsza wersja w postaci pakietu dla środowiska R – 

Landscapemetrics (Hesselbarth i in., 2019). Program Fragstats, którego użyjemy 

powstał na Uniwersytecie w Oregonie. Wykorzystuje on dane przestrzenne w modelu 

rastrowym. Aplikacja umożliwia obliczenie kilkudziesięciu miar krajobrazowych. 

W tym ćwiczeniu, dla pojedynczego rastra wejściowego obliczymy zestaw 

kilkudziesięciu wskaźników krajobrazowych na poziomie płatów, kategorii i całego 

krajobrazu. 

1. Dane do analiz 

Do analiz będziemy wykorzystywali przetworzoną cyfrową mapę litostratygraficzną 

rejonu OPN. Powstała ona w wyniku digitalizacji opracowanej w 1997 roku Mapy 

geologicznej Ojcowskiego Parku Narodowego wraz z otuliną (Płonczyński, 2001). 

Utworzona mapa wymagała uzupełnienia o fragmenty nieobjęte opracowaniem, 

znajdujące się poza otuliną OPN. Źródło danych uzupełniających stanowiła Szczegółowa 

mapa geologiczna Polski (SMGP) – arkusz Skała (Płonczyński, 2000a, 2000b). 

Opracowana klasa obejmuje przestrzenną zmienność piętnastu ogniw 

litostratygraficznych (Ryc. 1). 

http://home.agh.edu.pl/~bartus/click.php?id=102
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Ryc. 1. Mapa litostratygraficzna OPN i jego okolic według (Płonczyński, 2000b, 2001), 
zmienione. Górna jura: 2 – wapienie skaliste i uławicone (nierozdzielone), 3 – wapienie 
skaliste, 4 – wapienie ławicowe z krzemieniami, 5 – wapienie margliste płytowe; górna 
kreda: 7 – piaski, 8 – zlepieńce, miejscami piaskowce wapniste i piaski, 10 – margle 
glaukonitowe, 11 – opoki z czertami, wapienie margliste i margle; paleogen: 12 – 

rumosze krzemienne i gliny zwietrzelinowe z krzemieniami, 19 – piaski miejscami ilaste; 
plejstocen: 14 – lessy; plejstocen / holocen: 15 – rumosze skalne; holocen: 16 – piaski, 

żwiry oraz mułki, gliny i piaski (mady) tarasów zalewowych, 17 – martwice wapienne, 
18 – namuły den dolinnych 

2. Utworzenie mapy litofacjalnej 

Mapę zróżnicowania litologicznego (litofacjalnego) (Błąd! Nie można odnaleźć 

źródła odwołania.) utworzyliśmy już przy okazji badań struktury cechy krajobrazu 

z zastosowaniem oprogramowania Fragstats. Kryterium doboru kategorii ma stanowić 

zmienność litofacjalna. W wyniku reklasyfikacji powstała klasa złożona z piętnastu 

kategorii. Jeśli jej nie posiadasz należy pobrać surowy zbiór danych zmienności 

litostratygraficznej (Ryc. 1), zwalidować i poprawić jego geometrię, a następnie 

sklasyfikować go pod względem zróżnicowania litofacji (atrybut LITOLOGIA). Jeśli jej nie 

posiadasz powinieneś utworzyć Map_Litofacje oraz Layout_Litofacje. Klasa 
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zmienności litofacjalnej (Błąd! Nie można odnaleźć źródła odwołania.) będzie 

wykorzystywana do oceny różnorodności litofacjalnej. 

3. Pobieranie i instalacja program Fragstats 

3.1. Program Fragstats można pobrać z tej lokalizacji. 

3.2. Zainstaluj oprogramowanie na swoim domowym komputerze. 

4. Otwieranie Fragstats 

4.1. Otwórz program Fragstats. 

4.2. Jeżeli nastąpiły jakieś problem, zajrzyj do dokumentacji. 

 

 

 

5. Tworzenie nowego modelu 

Po uruchomieniu oprogramowania, w celu analizy krajobrazu należy utworzyć 

model "Fragstats". Model Fragstats jest po prostu plikiem projektowym zawierającym 

kompletną informację potrzebną do przetwarzania pliku opisującego analizowany 

krajobraz. 

5.1. Po otwarciu aplikacji Fragstats, kliknij przycisk Nowy znajdujący się na 

pasku narzędzi lub wybierz Nowy z menu głównego File (Plik). Narzędzie 

utworzy pusty model, który będzie gotowy do parametryzacji (Ryc. 2). 

UWAGA 

Program Fragstats miewa problemy ze ścieżkami do plików zawierającymi polskie znaki diakrytyczna. Unikaj ich. 

https://fragstats.software.informer.com/4.2/
https://ibis.geog.ubc.ca/courses/geob479/labs/fragstats.help.4.pdf
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Ryc. 2. Panel wejściowy programu Fragstats 

6. Rasteryzacja plików 

Oprogramowanie Fragstats współpracuje z danymi przestrzennymi o geometrii 

poligonowej przetworzonymi do modelu rastrowego. Aby móc wykonać analizy 

krajobrazowe każdorazowo musimy przekonwertować dane z modelu wektorowego do 

modelu rastrowego. 

6.1. Jeśli to konieczne otwórz ArcGIS Pro. 

6.2. W polu wyszukiwarki narzędzi Command Search wyszukaj narzędzie Feature 

to Raster (Obiekt do rastra). Standardowo znajduje się ono w toolboxie 

Convertion Tools > To Raster > Feature to Raster. 

6.3. Jako klasę do rasteryzacji wybierz zmienność litostratygraficzną 

litostratygrafia. 

6.4. Będziemy ją rasteryzować w oparciu o wartości atrybutu kod. Ma on wartości 

uzależnione od litologii. 

6.5. W folderze projektowym \GEODIVERSITY\ utwórz podfolder \RASTER\ 

(Ryc. 3). Będziemy do niego zapisywali przekonwertowane rastry. 
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Ryc. 3. Podfolder \RASTER\ utworzony w folderze projektowym \GEODIVERSITY\ 

6.6. Plikowi wynikowemu rasteryzacji nadaj nazwę litofacje. 

6.7. Jako wielkość komórki rastra wybierz 10 metrów (Ryc. 4). 

 
Ryc. 4. Okno dialogowe narzędzia rasteryzacji klas wektorowych Feature to Raster 

6.8. Po wypełnieniu okna dialogowego narzędzia geoprzetwarzania naciśnij 

przycisk Run. 

We wskazanej lokalizacji zostanie utworzony raster zmienności litofacjalnej. 

Program dodaje go na scenę mapy. 

7. Export obrazu ESRI grid do formatu ASCII 

Jednym z najlepszych sposobów na umożliwienie współpracy programu Fragstats 

z plikami grid utworzonymi w ArcGIS Pro, jest ich eksport do postaci grid ASCII oraz 

otwarcie takiego pliku w programie Fragstats. Pliki ASCII stanowią jeden ze sposobów 

zapisu danych rastrowych. Wartości komórek rastra są w nich zakodowane w postaci 

matrycy wartości wyświetlanego atrybutu. Matryca posiada n kolumn odpowiadających 

liczbie pikseli wzdłuż szerokości rastra i k wierszy odpowiadających liczbie pikseli wzdłuż 
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jego wysokości. Każda wartość w matrycy jest rozdzielona od wartości w sąsiednich 

kolumnach znakiem spacji, co pozwala na łatwą interpretację pliku. 

7.1. Jeśli dotąd nie masz otwarty – dodaj na scenę mapy grid (raster) 

zróżnicowania litofacjalnego litofacje. 

7.2. W podfolderze \RASTER\ utwórz podfolder \ASCII\, do którego 

przekonwertujemy grid litofacje (Ryc. 5). 

 
Ryc. 5. Podfolder \ASCII\ utworzony w folderze projektowym \GEODIVERSITY\RASTER\ 

7.3. W polu wyszukiwarki narzędzi Command Search wyszukaj narzędzie Raster 

to ASCII. Standardowo znajduje się ono w ArcToolbox > Conversion Tools > 

From Raster > Raster to ASCII. 

7.4. W polu Input raster wprowadź grid litofacje (Ryc. 6). 

7.5. Wynikowy plik tekstowy o nazwie litofacje.txt zapisz do posiadanego 

folderu projektowego i nowego podfolderu \Raster\ASCII\. 

 
Ryc. 6. Okno dialogowe konwersji rastrów do formatu ASCII 

7.6. Po wypełnieniu okna dialogowego narzędzia geoprzetwarzania naciśnij 

przycisk Run. 

8. Import grida 

8.1. Otwórz utworzony plik tekstowy litofacje.txt w dowolnym edytorze 

tekstowym (Ryc. 7). 
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Ryc. 7. Struktura pliku ASCII grid litofacje.txt 

W pierwszych 6-ciu wierszach pliku litofacje.txt znajduje się nagłówek pliku 

(Ryc. 7). W pierwszych dwóch wierszach przedstawione są liczby kolumn (ncols) 

i wierszy (nrows). W przypadku omawianego pliku, obraz zawiera 900 kolumn i 1000 

wierszy. W trzecim i czwartym wierszu zadeklarowano współrzędne płaskie (w wybranym 

Projected Coordinate System – PCS) lewego dolnego narożnika rastra (xllcorner, 

yllcorner). Pamiętamy, że naszym PCS jest odwzorowanie PUWG „1992”. W piątym 

wierszu nagłówka, w atrybucie cellsize zadeklarowano wielkość komórki podstawowej 

rastra (piksela). Jak widać, w naszym przypadku wielkość ta wynosi 10 m × 10 m 

(100 m2). Ostatni wiersz nagłówka deklarują wartości komórek, które stanową tło (Null). 

W ostatnim wierszu nagłówka zadeklarowano wartość wskazującą na brak danych wynosi 

ona -9999 (w przypadku naszego zbioru nie ma takich pikseli). Wszystkie wartości 

zawarte w nagłówku będą nam potrzebne na etapie przygotowania pliku do analizy 

w programie Fragstats. Informacje nagłówka muszą zostać usunięte z pliku (skasowane), 

przed etapem analizy w Fragstats. Dlatego warto je zapisać sobie w osobnym pliku. 

8.2. Zaznacz cały nagłówek i usuń go z pliku (Ryc. 8). Usuniętą zawartość zapisz 

do pliku nagłówek.txt. Zapisz zmodyfikowany plik pod nazwą 

litofacje.asc. 
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Ryc. 8. Struktura pliku litofacje.txt pozbawionego nagłówka 

8.3. W programie Fragstats zaimportuj grid do analizy. W tym celu kliknij 

przycisk Add Layer (Dodaj Warstwy) znajdujący się wewnątrz Batch 

management (Menedżera wsadów) znajdującego się w zakładce Input layers 

(Warstwy wejściowe) (Ryc. 9). 

 
Ryc. 9. Okno dialogowe Wybór danych wejściowych (Select input dataset) 

8.4. W oknie dialogowym Select input dataset (Wybór zbioru danych 

wejściowych), w polu Data type selection (Wybór typu danych), wybierz typ 

danych Raw ASCII grid, a następnie kliknij przycisk [...] i przejdź do 
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folderu z danymi projektowymi \GEODIVERSITY\RASTER\ASCII\ i wybierz 

plik ASCII grid litofacje.asc (Ryc. 10). 

 
Ryc. 10. Okno dialogowe wyboru zbioru danych wejściowych 

8.5. Uzupełnij parametry pliku grid: row count (liczbę wierszy), column count 

(liczbę column), background value (wartość tła), cell size (wielkość piksela) 

w jednostce mapy oraz No data value (Wartość komórek pozbawionych 

danych). Do uzupełnienia parametrów wykorzystaj dane z pliku 

nagłówek.txt (Ryc. 11). 

 
Ryc. 11. Okno dialogowe wyboru zbioru danych wejściowych z uzupełnionymi 
parametrami pliku grid 

Domyślnie wartość kategorii tła jest ustawiona na 999 ale, o ile rozumiemy 

konsekwencje, można ją zmienić na dowolną wartość. Tło to kategoria używana do 

rozróżniania komórek, które chcemy podczas analizy zignorować. Mogą to być komórki, 

które np. z powodu braku danych, nie mogły zostać sklasyfikowane jako prawdziwe 

kategorie pokrycia terenu lub komórki, które po prostu chcemy potraktować jako część 

macierzy tła w krajobrazie. 

 

 

 

 

UWAGA 

Podczas importu danych w formacie Geotiff (lub ArcGrid), informacje o atrybutach grida (liczba wierszy (y), 

liczby kolumn (x), rozmiar komórki i wartości nodata) są odczytywane z nagłówka pliku grid, a więc pól tych nie 

potrzeba wprowadzać i ich edycja jest wtedy wyłączona (są szare). Jedyny atrybut, który może wymagać 

modyfikacji to wartość tła. 
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8.6. Po uzupełnieniu danych naciśnij przycisk OK. 

9. Parametry analizy 

Zanim przystąpimy do obliczeń, musimy zadeklarować kilka niezbędnych 

parametrów analizy. 

9.1. Wybierz zakładkę Analysis parameters (Parametry analizy) znajdującą się 

w lewym panelu interfejsu użytkownika. 

Musimy wybrać 4-komórkową, bądź 8-komórkową regułę sąsiedztwa, która będzie 

stosowana podczas obliczeń wskaźników krajobrazowych (Ryc. 12). 

A B 

       

       

       

       

       

       

       
 

       

       

       

       

       

       

       
 

Ryc. 12. Definicja sąsiedztwa cztero- (A) i ośmio-komórkowego (B) 

Wybór reguły sąsiedztwa wpływa na wyniki analiz (Ryc. 13). 

A B 

1 2 3 3 3 4 

1 1 5 6 6 4 

1 1 5 6 6 4 

7 1 8 9 6 4 

10 10 10 9 6 4 

11 11 10 12 12 12 
 

1 2 3 3 3 4 

1 1 2 5 5 4 

1 1 2 5 5 4 

6 1 7 8 5 4 

9 9 9 8 5 4 

10 10 9 11 11 11 
 

Ryc. 13. Zastosowanie reguły sąsiedztwa cztero- (A) i ośmio-komórkowego (B); kolorami 
oznaczono rzeczywistą przynależność pikseli do płatów zaś liczbami – przynależność 

teoretyczną obliczoną na podstawie odpowiedniej reguły 

W przykładzie z Ryc. 13A, zastosowanie reguły sąsiedztwa czterokomórkowego (bez 

uwzględniania komórek diagonalnych) powoduje że liczba obliczonych płatów wynosi 12, 

a w przypadku zastosowanie reguły sąsiedztwa ośmiokomórkowego (uwzględniającego 

komórki diagonalne) (Ryc. 13B) liczba obliczonych płatów wynosi 11. 

W tym ćwiczeniu wykorzystamy sąsiedztwo 8-komórkowe oraz strategię bez 

próbkowania. 

9.2. Z menu w zakładce Analysis parameters (Parametry analizy), w polu General 

options wybierz opcję “Use 8 cell neighborhood rule”. 



Analiza struktury krajobrazu w Fragstats 

11 

9.3. W polu Sampling strategy wybierz opcję No sampling, a następnie wybierz 

wszystkie trzy opcjonalne rodzaje wskaźników: Patch metrics (wskaźniki na 

poziomie płatów), Class metrics (wskaźniki na poziomie kategorii) oraz 

Landscape metrics (wskaźniki na poziomie krajobrazu) (Ryc. 14). 

 
Ryc. 14. Parametry analizy 

 

 

 

 

9.4. Na koniec zaznaczmy opcję Automatically save results (Zapisz 

automatycznie wyniki). Spowoduje to automatyczne wygenerowanie plików 

wynikowych z obliczonymi wartościami wybranych metryk krajobrazowych. 

9.5. W folderze \GEODIVERSITY\RASTER utwórz podfolder \FRAGSTATS\, 

w którym będziemy gromadzili wyniki analiz. 

9.6. Wybierzmy lokalizację, w której zostaną zapisane pliki wynikowe: 

\GEODIVERSITY\RASTER\FRAGSTATS\litofacje. Ostatni człon podanej 

ścieżki „litofacje” będzie tym razem nagłówkiem plików wynikowych 

analizy. Jeżeli wybrano metryki dla trzech poziomów analizy krajobrazu 

(płatów, kategorii i całego krajobrazu), generowane będą trzy pliki 

wynikowe: litofacje.patch, litofacje.class i litofacje.land. 

Do opisu struktury krajobrazu wykorzystujemy model płatów-korytarzy-matrycy 

(Ryc. 15) (Forman & Godron, 1991), w którym homogeniczne jednostki nazywane 

płatami, są połączone korytarzami i występują w pewnym tle nazywanym matrycą. Opis 

składników środowiska dokonywany jest na trzech poziomach szczegółowości: ogólnym 

(poziom krajobrazu) bardziej szczegółowym (poziom kategorii) i najbardziej 

szczegółowym – poziomie płatów. Dla każdego poziomu będziemy wybierać 

interesujące nas wskaźniki. 

UWAGA 

Aby móc uruchomić obliczenia, musimy mieć wybrany przynajmniej jeden rodzaj wskaźników krajobrazowych (na 

poziomie płatów / kategorii lub całego krajobrazu). 
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Ryc. 15. Model krajobrazu Model krajobrazu płaty-korytarze-matryca (Gökyer, 2013) 

10. Generowanie indeksów płatów 

Opcjonalnie można zaznaczyć pole wyboru Generate patch ID file. Zaznaczenie tej 

opcji spowoduje, że Fragstats wygeneruje plik identyfikatorów płatów. Format pliku 

będzie identyczny jak danych wejściowych. Każda komórka będzie miała przypisany 

unikalny identyfikator ID płata, do którego należy. Tak więc wszystkie komórki należące 

do płata 1 będą miały ID = 1. Zaś wszystkim komórkom należącym do płata o ID = 2, 

zostanie przypisana wartość 2 itd. Dzięki temu unikalne wartości identyfikatora płata 

będą odpowiadać unikalnym wartościom identyfikatora płata w polu PID pliku metryk 

krajobrazowych obliczanych na poziomie płatów (nazwa.patch). Dzięki temu plik 

identyfikatora płatów może zostać użyty do połączenia wyników wskaźników obliczonych 

na poziomie płatów z wynikami obliczonymi na poziomie krajobrazu. Połączenia 

dokonujemy w oprogramowaniu ArcGIS Pro. 

11. Wybór metryk krajobrazowych 

Wybierzemy teraz wskaźniki do obliczenia dla poziomu płatów, kategorii i całego 

krajobrazu. Definicje najważniejszych metryk zostały przedstawione w Miary 

krajobrazowe. 

11.1. Aby rozpocząć, w głównym oknie programu, w prawym panelu (Ryc. 2), 

kliknij przycisk Patch metrics (Metryki płatów). 

W górnej części okna znajduje się pięć zakładek grupujących rodzaje metryk 

krajobrazowych: Area-Edge (Powierzchnia-krawędzie, Ryc. 16), Shape (Kształt, Ryc. 17), 

Core Area (Strefy centralne, Ryc. 18), Contrast (Kontrastu, Ryc. 19) oraz Aggregation 

(Agregacji, Ryc. 20). 

http://home.agh.edu.pl/~bartus/click.php?id=102
http://home.agh.edu.pl/~bartus/click.php?id=102
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Ryc. 16. Dostępne metryki krajobrazowe powierzchni-krawędzi obliczane na poziomie 
płatów 

 
Ryc. 17. Dostępne metryki krajobrazowe kształtu obliczane na poziomie płatów 

 
Ryc. 18. Dostępne metryki krajobrazowe stref centralnych obliczane na poziomie płatów 
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Ryc. 19. Dostępne metryki krajobrazowe kontrastu obliczane na poziomie płatów 

 
Ryc. 20. Dostępne metryki krajobrazowe agregacji obliczane na poziomie płatów 

Z każdego z dostępnych zestawów wskaźników krajobrazowych można wybrać do 

obliczeń dowolną metrykę. Można także wybrać wszystkie metryki za pomocą przycisku 

"Select all". 

 

 

 

 

11.2. Z grupy metryk Powierzchnia-krawędzie, wybierz metryki: Powierzchnia 

płatów (AREA) i obwód płatów (PERIM) (Ryc. 21). 

UWAGA 

w zakładce Aggregation (Wskaźniki agregacji), jeśli wybierzesz Proximity index (Indeks zbliżenia) lub Similarity index 

(Indeks podobieństwa), musisz również określić Search radius (Promień wyszukiwania). Indeks podobieństwa wymaga 

również tabeli wag podobieństwa (zob. poniżej). Aby określić promień wyszukiwania, kliknij przycisk [...] 

i wprowadź żądany promień wyszukiwania wyrażony w metrach, np. 500. 
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Ryc. 21. Wybór metryk krajobrazowych powierzchni-krawędzi obliczanych na poziomie 
płatów 

11.3. Naciśnij teraz przycisk Metryki na poziomie kategorii (Class metrics). 

W górnej części okna, ponownie znajdziemy pięć zakładek grupujących 

rodzaje metryk krajobrazowych: Area-Edge (Powierzchnia-krawędzie), 

Shape (Kształt), Core Area (Strefy centralne), Contrast (Kontrastu) oraz 

Aggregation (Agregacji). Podobnie jak poprzednio, wskaźniki możemy 

wybierać pojedynczo albo przyciskiem "Wybierz wszystko". 

11.4. Z kategorii Powierzchnia-krawędzie wybierzmy metryki: powierzchnię 

zajmowaną przez wszystkie płaty danej kategorii (TA), procentowy udział 

kategorii w krajobrazie (PLAND), wskaźnik największej jednostki (LPI), 

długość krawędzi (TE), gęstość krawędzi wszystkich jednostek (ED) oraz 

przeciętną wielkość zajmowaną przez płaty danej kategorii (AREA – Mean 

MN) oraz ich współczynnik zmienności (AREA – Coefficient of Variation CV) 

(Ryc. 22). 

 
Ryc. 22. Wybór metryk krajobrazowych powierzchni-krawędzi obliczanych na poziomie 
kategorii 

11.5. Spośród miar kształtu (na poziomie kategorii) wybierzmy: wskaźnik kształtu 

(SHAPE) oraz wymiar fraktalny (FRAC). Oba wskaźniki są obliczane na 

podstawie własności wszystkich płatów danej kategorii, dlatego są dla nich 
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dostępne estymatory różnych parametrów statystycznych. Wybierzemy 

średnią arytmetyczną (MN) oraz współczynnik zmienności (CV) (Ryc. 23). 

 
Ryc. 23. Wybór metryk krajobrazowych kształtu obliczanych na poziomie kategorii 

11.6. W analizach nie będziemy wykorzystywali żadnego wskaźnika 

krajobrazowego z grupy metryk stref centralnych, dlatego na kolejnej 

zakładce nie zaznaczamy żadnych wskaźników (Ryc. 24). 

 
Ryc. 24. Wybór metryk krajobrazowych stref centralnych obliczanych na poziomie 
kategorii 

11.7. Nie będziemy też wykorzystywali żadnego wskaźnika krajobrazowego 

z grupy metryk kontrastu, dlatego na zakładce Contrast także nie 

zaznaczamy żadnych wskaźników (Ryc. 25). 
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Ryc. 25. Wybór metryk krajobrazowych kontrastu obliczanych na poziomie kategorii 

11.8. Spośród miar skupienie (agregacji) wybierzmy: NP (Liczba płatów), PD 

(Gęstość płatów), DIVISION (Wskaźnik fragmentacji), IJI (Wskaźnik 

zróżnicowania granic), PLADJ (Wskaźnik procent identycznego sąsiedztwa), 

AI (Wskaźnik agregacji) oraz ENN (Odległość do najbliższego elementu tej 

samej kategorii). Dla ostatniego wskaźnika wybierzmy estymatory średniej 

arytmetycznej (MN) oraz współczynnik zmienności (CV) (Ryc. 26). 

 
Ryc. 26. Wybór metryk krajobrazowych agregacji obliczanych na poziomie kategorii 

Przejdźmy teraz do metryk obliczanych na poziomie całego krajobrazu 

(Landscape metrics). Od razu zauważamy, że do standardowego zestawu zakładek został 

dodany zbiór miar różnorodności (Diversity) (Ryc. 27). 
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Ryc. 27. Wybór metryk krajobrazowych powierzchni-krawędzi obliczanych na poziomie 
całego krajobrazu 

11.9. Spośród miar Powierzchnia-krawędzie obliczanych na poziomie całego 

krajobrazu wybierzmy metryki: CA/TA (Całkowita powierzchnię krajobrazu), 

LPI (Część powierzchni zajmowaną przez największy płat), TE (Długość 

krawędzi) oraz ED (Gęstość krawędzi) (Ryc. 27). 

11.10. Pomińmy zakładki: Shape, Core area, Contrast i otwórzmy zakładkę 

Aggregation. 

11.11. Zaznaczmy na niej metryki: NP (Liczba płatów) oraz PD (Gęstość płatów) 

(Ryc. 28). 

 
Ryc. 28. Wybór metryk krajobrazowych skupienia, obliczanych na poziomie całego 
krajobrazu 

11.12. Przejdźmy do zakładki miar różnorodności (Diversity) i wybierzmy 

następujące wskaźniki krajobrazowe: PR (Liczba kategorii), SHDI (Wskaźnik 

różnorodności Shannona-Weavera), SIDI (Wskaźnik różnorodności 

Simpsona) oraz SHEI (Wskaźnik równomierności Shannona) (Ryc. 29). 
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Ryc. 29. Wybór metryk krajobrazowych różnorodności obliczanych na poziomie całego 

krajobrazu 

11.13. Po uzupełnieniu wszystkich niezbędnych metryk, zachowajmy plik 

projektowy Fragstats. W tym celu naciśnij przycisk Save. Plik projektowy 

zapiszmy w folderze \GEODIVERSITY\RASTER\FRAGSTATS nazwijmy go 

litofacje.fca. 

12. Wykonanie analiz 

12.1. Aby uruchomić przygotowane analizy, należy nacisnąć zielony przycisk Run, 

znajdujący się w górnej części panelu użytkownika. 

W wyniku naciśnięcia przycisku Run, otworzone zostanie okno dialogowe Runnning 

(Ryc. 30). Możemy się z niego zorientować w ilości metryk wybranych do analizy. 

W naszym przypadku wybrano 2 metryki na poziomie płatów, 19 metryk na poziomie 

kategorii oraz 10 metryk na poziomie całego krajobrazu. Jeśli w Twoim przypadku opis 

jest inny – wróć i popraw wybór obliczanych metryk krajobrazowych. 

 
Ryc. 30. Okno dialogowe Runnning z krótkim raportem wybranych metryk 

krajobrazowych 

12.2. Za pomocą przycisku Proceed, znajdującego się w dolnej części okna 

dialogowego Runnning, uruchamiamy proces obliczeń metryk 

krajobrazowych. Pasek postępu informuje nas o postępie wykonywanych 

analiz. 

Wykonywane operacje oraz ewentualne błędy są rejestrowane w pliku logów 

aktywności widocznym w dolnej części panelu użytkownika (Ryc. 31). 
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Ryc. 31. Wpisy logów przy poprawnym przetwarzaniu danych 

Wyniki analiz są dostępne w programie pod przyciskiem Results (Ryc. 2, Ryc. 32). 

 
Ryc. 32. Okno wyników analiz miar krajobrazowych dla poziomu płatów 

O ile zaznaczono opcję Automatically save results (zob. pkt. 9.4), zostają także 

wyprowadzone do trzech zewnętrznych plików: litofacje.patch, litofacje.class 

i litofacje.land (Ryc. 33). 

 

Ryc. 33. Pliki wynikowe analiz wygenerowane przez program Fragstats 

13. Odczytywanie plików metryk krajobrazowych 

Wygenerowane zbiory wyników (Ryc. 33) są plikami tekstowymi. W celu dalszej 

obróbki i / lub interpretacji, należy je otworzyć w programie MS Excel. 
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13.1. Aby ułatwić podgląd wygenerowanych plików, zmień ich nazwy dodając na 

końcu każdego z nich rozszerzenie .txt. Teraz można je bezproblemowo 

otworzyć w każdym edytorze tekstowym (Ryc. 34). 

 
Ryc. 34. Podgląd pliku litofacje.class.txt 

Plik będzie znacznie bardziej czytelny jeśli zaimportujemy go do MS Excela. 

13.2. Aby zaimportować plik do MS Excel, otwórz w aplikacji pusty skoroszyt, 

a następnie wybierz Plik > Otwórz, a następnie wybierz ścieżkę do pliku 

litofacje.class.txt. 

13.3. Otworzy się kreator importu tekstu (Ryc. 35). Wybierz typ pliku, który 

najlepiej opisuje dane źródłowe jako „Rozdzielany”, a następnie naciśnij 

przycisk Dalej >. 

 
Ryc. 35. Kreator importu tekstu MS Excel z importowanym plikiem litofacje.class.txt 

13.4. Jako ogranicznik rozdzielający kolumny wybierz przecinek. 

13.5. Kliknij kolejno: Dalej > oraz Zakończ. 
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W wyniku importu pliku litofacje.class.txt, w programie Excel pojawi się 

zestaw obliczonych metryk dla poziomu kategorii (Ryc. 36). Kolumna TYPE definiuje 

kategorie wydzieleń litofacjalnych. 

 
Ryc. 36. Fragment arkusza kalkulacyjnego MS Excel z zaimportowanym plikiem metryk 
krajobrazowych na poziomie kategorii 

14. Interpretacja wyników analiz 

Interpretacja miar krajobrazowych wymaga dokładnego zapoznania się z ich 

definicjami. Poniżej zostanie przedstawiona przykładowa ilościowa interpretacja jednego 

z komponentów krajobrazu rejonu Ojcowskiego Parku Narodowego – zmienności 

litofacjalnej. 

Analizowany obszar posiada powierzchnię 9 000 ha (90 km2; Tab. 1). 

Tab. 1. Miary krajobrazowe zmienności podstawowych form rzeźby terenu na poziomie 
krajobrazu 

TA [ha] NP [-] 

PD 

[liczba/100 h

a] 

LPI 

[%] 
TE [m] ED [m/ha] PR [-] SHDI [-] SIDI [-] SHEI [-] 

9000 601 6,7 30,9 738 800 82,1 15 1,3 0,6 0,5 

Model zmienności litofacjalnej obejmuje piętnaście kategorii litofacjalnych (Błąd! 

Nie można odnaleźć źródła odwołania.; Tab. 2). 

Tab. 2. Wydzielenia litostratygraficzne rejonu OPN 

Lp. Symbol Opis 

1 l lessy 

2 mg margle glaukonitowe 

3 mt martwice wapienne 

4 n namuły den dolinnych 

5 o+w+me opoki z czertami, wapienie margliste, margle 

6 p piaski 

7 p+i piaski miejscami ilaste i iły 

8 p+z+gl piaski i żwiry oraz mułki, gliny i piaski (mady) tarasów zalewowych 0,5–3 m n.p. rzeki 

9 rs rumosze skalne 

10 ru+gl rumosze krzemienny gliny z krzemieniami, zwietrzelinowe 

11 wme wapienie margliste, płytowe 

12 wsk wapienie skaliste 

13 wsk+wł wapienie skaliste i wapienie ławicowe (nierozdzielone) 

14 wł wapienie ławicowe z krzemieniami (oraz nierozdzielone wapienie ławicowe i skaliste) 

15 zc+p zlepieńce, miejscami piaskowce wapniste i piaski 

 

Obserwowane wydzielenia występują w łącznej liczbie 601 płatów. Odpowiada to 

przeciętnej liczbie ok. 6,7 płatów/km2. Płat o największej powierzchni zajmował ponad 

http://home.agh.edu.pl/~bartus/click.php?id=102
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30,9% powierzchni analizowanego obszaru. Łączna długość granic występujących 

pomiędzy płatami wynosiła ponad 738 km. Na poziomie krajobrazu, kryterium cechuje 

się wysokim poziomem różnorodności. Prawdopodobieństwo zdarzenia, w którym dwie 

losowo wybrane komórki są położone wewnątrz różnych wydzieleń litofacjalnych wynosi 

60%. 

Analizowany krajobraz charakteryzuje się wysokim zróżnicowaniem udziałów 

poszczególnych wydzieleń litofacjalnych (Ryc. 37). 

 
Ryc. 37. Udział podstawowych form rzeźby terenu w krajobrazie obszaru OPN, symbol 

kategorii jak w Tab. 2 

Kategorią występującą w nim najczęściej są lessy (l). Obejmują one ponad 64,5% 

analizowanego obszaru (Tab. 3). Są reprezentowane stosunkowo niską liczbą 40 płatów. 

Na 1 km2 analizowanej powierzchni, przeciętnie występuje 0,4 płata należącego do tej 

kategorii. Największy homogeniczny fragment analizowanego obszaru obejmuje 

wydzielenie lessów. Zajmuje on aż ok. 30,9% analizowanej powierzchni. 

Tab. 3. Miary powierzchni i krawędzi zmienności litofacjalnej rejonu OPN. Symbole 
kategorii jak w Tab. 2 

Kategoria 
CA 

[ha] 

PLAND 

[%] 
NP [–] 

PD 

[liczba/100 ha] 

LPI 

[%] 

TE 

[m] 

ED 

[m/ha] 

AREA 

(MN) 

[ha] 

AREA 

(CV) 

[%] 

l 5807,0 64,5 40 0,4 30,9 458660 51,0 145,2 338,1 

n 683,3 7,6 92 1,0 0,7 323620 36,0 7,4 131,4 

wsk+wł 1183,3 13,1 116 1,3 0,9 319620 35,5 10,2 143,3 

p+z+gl 304,4 3,4 6 0,1 2,1 91130 10,1 50,7 122,6 

wł 173,1 1,9 36 0,4 0,3 52930 5,9 4,8 102,4 

mg 0,9 0,0 2 0,0 0,0 550 0,1 0,4 31,8 

wsk 367,6 4,1 242 2,7 0,2 142870 15,9 1,5 178,7 

ru+gl 265,7 3,0 33 0,4 1,0 45470 5,1 8,1 199,4 

rs 5,5 0,1 4 0,0 0,0 2660 0,3 1,4 8,6 

o+w+me 203,4 2,3 20 0,2 0,7 36340 4,0 10,2 144,1 

mt 0,9 0,0 2 0,0 0,0 640 0,1 0,4 5,6 

wme 1,5 0,0 1 0,0 0,0 780 0,1 1,5 0,0 

p+i 0,7 0,0 1 0,0 0,0 440 0,0 0,7 0,0 

p 1,2 0,0 3 0,0 0,0 880 0,1 0,4 74,4 

zc+p 1,5 0,0 3 0,0 0,0 1010 0,1 0,5 44,2 

l; 65%n; 8%

wsk+wł; 13%

p+z+gl; 3%

wł; 2%

mg; 0%

wsk; 4%
ru+gl; 3%

rs; 0%

o+w+me; 2%

mt; 0%

wme; 0%

p+i; 0%

p; 0%

zc+p; 0%
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Komórki płatów lessów cechują się bardzo wysokim poziomem skupienia. 

Współczynnik agregacji (AI) osiąga 98,0% (Tab. 4), co stanowi najwyższą wartość dla tej 

klasy. Aż 97,9% komórek płatów sąsiaduje z elementami tej samej kategorii. Całkowita 

długość granic wynosząca około 458 km (Tab. 3) i gęstość granic na poziomie 51 m/ha 

świadczą o niewielkim stopniu komplikacji krawędzi płatów. Stosunkowo niewielka liczba 

jednostek oraz duża łączna powierzchnia sprawiają, że przeciętna wielkość płatów 

kategorii wynosi około 145 ha. Należy jednak zaznaczyć, że rozmiar płatów wykazuje 

skrajnie wysoki poziom zmienności (338%). Wartość przeciętna wskaźnika kształtu 

wykazuje niższe wartości w stosunku do dwóch pozostałych kategorii (n oraz p+z+gl), co 

wskazuje na większą regularność ich obrysów. Płaty lessów są od siebie oddalone 

o przeciętnie około 60,8 m. Statystycznie sąsiadują z około 58% pozostałych kategorii. 

Tab. 4. Miary kształtu i agregacji rejonu OPN. Symbole kategorii jak w Tab. 2 

Kategoria 

SHAPE 

(MN) 

[–] 

SHAPE 

(CV) 

[%] 

FRAC  

(MN) 

[-] 

FRAC  

(CV) 

[%] 

ENN 

(MN) 

[m] 

ENN 

(CV) 

[%] 

PLADJ 

[%] 

IJI 

[%] 

DIVISION 

[–] 
AI [%] 

l 2,2 80,6 1,1 5,5 60,8 0,5 97,9 58,3 0,9 98,0 

n 3,2 40,5 1,2 5,4 186,3 0,1 88,0 41,9 1,0 88,4 

wsk+wł 2,1 44,3 1,1 5,9 42,2 0,6 93,2 56,3 1,0 93,5 

p+z+gl 5,1 37,5 1,2 2,7 960,0 0,0 92,4 51,7 1,0 92,9 

wł 1,8 28,3 1,1 3,8 268,7 0,0 92,0 53,5 1,0 92,7 

mg 1,4 21,1 1,1 4,6 3056,3 0,0 79,0 34,1 1,0 88,5 

wsk 1,3 22,0 1,1 3,4 85,5 0,1 90,2 49,1 1,0 90,7 

ru+gl 1,4 21,1 1,1 3,3 268,5 0,1 95,7 41,8 1,0 96,3 

rs 1,4 11,1 1,1 2,2 1676,2 0,0 87,9 66,5 1,0 91,8 

o+w+me 1,6 41,0 1,1 4,6 390,0 0,0 95,4 36,1 1,0 96,1 

mt 1,2 3,7 1,0 0,7 3144,0 0,0 82,0 25,4 1,0 91,8 

wme 1,6 0,0 1,1 0,0  N/A   N/A  87,3 0,0 1,0 95,1 

p+i 1,3 0,0 1,1 0,0  N/A   N/A  84,1 25,3 1,0 95,9 

p 1,2 12,6 1,0 3,2 146,8 0,3 82,1 38,7 1,0 90,6 

zc+p 1,3 4,3 1,1 0,3 1247,3 0,0 81,4 33,5 1,0 88,9 

Drugą kategorią pod względem wielkości zajmowanej powierzchni stanowią 

odsłonięcia wapieni skalistych i wapieni ławicowych (nierozdzielone; wsk+wł) (Ryc. 37). 

Obszary położone na płatach tego wydzielenia pokrywają około 13,1% badanego obszaru 

(Tab. 3). Kategoria cechuje się stosunkowo wysoką liczbą 116 płatów. Stanowi to 

zaledwie 1,3 płata/km2. Największy obiekt pokrywa około 0,9% całego obszaru. 

Przeciętna wartość wskaźnika kształtu wynosi 2,1 (Tab. 4). Kategoria cechuje się 

długością granic około 319 km, przy gęstości około 35,5 m/ha (Tab. 3). Wielkość płatów 

jest bardzo zróżnicowana. Współczynnik zmienności osiąga aż 143,3%. Przeciętna 

wielkość obiektów wynosi około 10 ha. Komórki płatów są silnie ze sobą skupione. 

Świadczą o tym wysokie wartości wskaźników: agregacji (około 93,5%) oraz 

identycznego sąsiedztwa (93,2%). Przeciętna odległość pomiędzy odsłonięciami wapieni 

skalistych i nierozdzielonych wapieni ławicowych wynosi tylko około 42,2 m. Obiekty 

kategorii statystycznie graniczą z 56,3% wszystkich kategorii. 

W opisywanym modelu zróżnicowania litofacjalnego, namuły den dolinnych (n) 

zajmują 7,6% analizowanego obszaru (Tab. 3). Kategoria jest reprezentowana przez 

99 jednostek. Gęstość ich występowania wynosi około 1 płat/ha. Obiekty posiadają 

stosunkowo duże rozmiary (przeciętnie 7,4 ha, przy zmienności parametru na poziomie 
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około 131%). Największy obiekt obejmuje 0,7% badanej przestrzeni. Względnie wysoka 

liczba płatów powoduje, że całkowita długość granic obiektów kategorii wynosi ponad 

323 km. Jest to równoznaczne z gęstością granic około 36 m/ha. Kształty płatów są 

wydłużone i przez to bardzo nieregularne (Tab. 4). Poligony są od siebie oddalone 

przeciętnie o 186,3 m. Komórki obiektów tej kategorii są silnie skupione. Około 12% 

z nich graniczy płatami innych kategorii. Obiekty statystycznie sąsiadują z nieco ponad 

42% pozostałych kategorii. 

Ostatnim wydzieleniem krajobrazu, które zostanie tu szerzej opisane są odsłonięcia 

wapieni skalistych (wsk). Ich płaty zajmują łącznie 4,1% powierzchni całego obszaru 

badań (Tab. 3). Przeciętna wielkość jednostek tej kategorii litofacjalnej jest niewielka 

i wynosi około 1,5 ha (przy skrajnie wysokiej zmienności na poziomie około 178%). Na 

jednym km2, przeciętnie występuje 2,7 płatów tej kategorii. Największy płat wapieni 

skalistych pokrywa zaledwie 0,2% badanej przestrzeni. Kategoria cechuje się wysokim 

poziomem agregacji komórek (90,7%; Tab. 4) oraz wysoką gęstością długości granic 

wynoszącą około 16 m/ha. Płaty wapieni skalistych graniczą z obiektami niemal polowy 

pozostałych kategorii (49,1%). Stopień agregacji komórek płatów jest na dość wysokim 

poziomie około 90%. Średnia minimalna odległość pomiędzy płatami tej kategorii wynosi 

85,5 m. 

Pozostałe kategorie zmienności litofacjalnej występują w krajobrazie rzadziej 

(Ryc. 37). Z uwagi na dydaktyczny charakter niniejszego dokumentu ich opis zostanie tu 

pominięty.
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